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1. Downloading the App

To download the app on your smartphone, open your device’s app store and search for “iKickButts.” Look
for the app with the following icon and tap “Download” or “Install” to add the app to your device. When
the installation is complete, tap “Open” to launch the app

iWKick

Butts

2. Creating Your Account

To access the app’s features, you'll need to sign in or create an account. On the main login screen, tap
“Create Account” and follow the on-screen instructions to register. Once your account is set up, return
to the login screen and sign in using your credentials.

iKick iKickButts
'K'C BUttS Tobacco, E-Cigarette and Cannabis
Tobacco, E-Cigarette and Cannabis Waste
Waste
User Name *
Email *
Forgot password? Password *
Confirm Password *
Organization
[ By signing in, you agree to our Terms o e and
rivacy_Polic

Once you log in, a brief tutorial will guide you through using the app.

If you encounter any difficulties during the download or usage process, contact our team at
contact@ikickbutts.org, and they will be happy to assist you!



mailto:contact@ikickbutts.org

3. Submitting Observations — Explore Page
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Tag your photo 00O

Tag: 1 €A
Tag:1*
® Butts 7 T =
Select image source ® sutts 1 ]
Take Photo Tag:2*

After capturing or
uploading a  photo,
identify and categorize

A Ecg 1 @

Use Photo from Library

If an image contains

Tap the eye-and- the TEC waste by tapping multiple types of TEC
magnifying-glass icon to the product(s) in the waste or waste items
either capture a photo of image. Then, select the scattered  in  different
TEC waste using your TEC waste type from the locations you can
phone's camera or drop-down menu on the identify, Icategorize tag
upload a photo from your left and enter the and c'ount each ’ type;
phone's library. guantity on the right.

separately.

Edit the observation date: Mar 20, 2025 Mar 20, 2025 Edit the observation date: Mar 20, 2025
Edit the report time: 1:28 PM Edit the report time: 1:28 PM Edit the report time: ‘1:28 PM
Was the waste picked up? < » Was the waste picked up? 4. Was the waste picked up? @
Project 2 Project > Project ¥
Add Notes If you would like return Add Notes

to the tagging screen, tap
on the icon to the left of

Prior to submission, edit the image. This will

and review observation

details.  including  d retun  you to the Tap the slider next to

etails, including date, previous screen where “ :

time ick-u status - Was the waste picked
P P ) you can modify the TEC up?” to indicate if vou

project association, and waste type, count, or p: y

icked up the waste item.
notes. location. P P



None

Test project

None
Gunner's Team

Test project

Kris' Kool Project
Gunner's Team

Edit the observation date: Mar 20, 2025

SDSU Research Fou...

Kris' Kool Project

Edit the report time: 1:28 PM

was the waste picked up? \ ‘
Project Kris' Kool Project «

Add Notes If you have joined
multiple projects, you
will be asked which
project to submit the
observation to. Tapping
the drop-down menu,

CANCEL  OK
SDSU Research Fou...

CANCEL OK

Select the project you
would like to assign the
observation to. Please
note, if you are already
assigned to one project,

_ ‘ you can select which Or, you can remove the
the olz:servatmn will project that you would observation from any
aut'omatlcally ) be like the observation to projects by  selecting,
assigned that project. be assigned to. “None”

- Observations JAY - |

*.  Post\week % Al Types DOWNLOAD
< Al Projects < MapFilter On

Edit the observation date: Mar 20, 2025 ~
(©mapbod £
Edit the report time: 1:28 PM N O
Was the waste picked up? ‘ __ Mar 20, 2025 - 1:32pm
. ktran eoe

G
Project > roject v Mar 20, 2025 - 1:30pm

ktran
Add Notes P ower 1]

Mar 20, 2025 - 1:28pm
BBy ...

@ M

Explore Forum
CANCEL SUBMIT

Once submitted, you may view your own
Once you are done, tap the “Submit” button and other users’ observations submitted on
to submit your observation. Or tap “Cancel” both the interactive map and in a list
to cancel the observation submission. located beneath the map.

Q

Profile




4. Viewing TEC Waste Observations — Explore Page

Observations 0O Observations Ay - | Observations I

== Post week <5 Al Tupes DOWNLOAD = Post Week = Al Types DOWNLOAD == Post Week <= Al Types DOWNLOAD
= AlProjects | 3= MopFilter On =— T = AlProjects | % MapFiterOn

) 3
: |

©
(Omapbod

(Olmapkox
My Observations My Observations All My Observations
N—
__ Mar 20, 2025 - 1:32pm __ Mar 20, 2025 - 1:32pm __ Mar 20, 2025 - 1:32pm

& ktran see m oD .o w ktran oo

(- butts 1| butts 1 [ butts 1}

Mar 20, 2025 - 1:30pm Mar 20, 2025 - 1:30pm Mar 20, 2025 - 1:30pm
P kiran = 5 A | ran PR ktran —

n n H n H n

Tap the AII tab to.V|ew Tf-lp My Observatlon_s to Mar 20, 2025 - 128pm
observations submitted view your own submitted -
from all app users on both observations on both a Tap the compass icon to
amapandina map andina return to your current
chronological list below. chronological list below. default location.

- -:': Past 6 Months @  Cannabis DOWNLOAD

i

<= Past Week == All Types DOWNLOAD o
== All lojects == Map FRler On .§ -
) 4 E | MID-CITY
All Types 2 a g £ ~
All Times 8 2 T ® _@_
® Butts i &
Past Week = [
> o
Past Month B Other Tobacco Products @ meben
® Connabis Nov 12, 2024 - 2:00pm
hlara373 oo
Multipurpose (ex lighters, rolling papers) ’
@ Unsure Nov 07, 2024 - 9:03am
Map Filter Example: Selecting “Cannabis”
for the waste type filter, and “Past 6
Above the map, you can refine observations Months” for the time filter will display
displayed on map and reports by applying observations of cannabis waste taken over
filters based on criteria such as time period, the past 6 months on the map and

type, and projects. observation lists



- Observations 00

ST Post Week <= All Types DOWNLOAD

&

9”76‘,
Bene,
Y By
mapbox :
E

My Observations

Mar 20, 2025 - 1:30pm

2 ‘~ ktran

Tapping on any observation in the
observation list will highlight it on both the
map and the observation list. Similarly,
tapping on any observation in the map will
highlight it both on the map and the
observation list.

: .
. All Types i
N .
=~ Map Filter Off -
Please note that the Similarly,

All Types

Map Filter Off

- Past Week < All Types DOWNLOAD

<= All Projects <~ Map Filter On

%
~ @

o

My Observations

__ Mar 20, 2025 - 1:32pm

g Kktran oo

‘ All

4 AA AAAr amaA

Above the map, you have the option to
select the "Map Filter On" or “Map Filter
Off” If the map filter is “On,” this allows
you to narrow down the observations
shown in the lists below, based on the
location you have moved to on the map.

< Past week <= Al ypes DOWNLOAD

(Omapkox

All My Observations

If you experience any

please note issues  while loading

default for Map Filter is
set to “On” as this helps
prevent slowing of the
app. We recommend
only switching Map Filter
to “Off” if you would like
to see all observations
regardless of  your
current location.

that the default for the
Time Filter is set to “Past
Week” as this helps
prevent slowing of the
app. We recommend
only increasing the time
filter if you would like to
see other past
observations.

observations or applying
filters to the
observations list and/or
map, tapping the refresh
button (C) will refresh
the observations
displayed on the map
and observation list. You
can also restart the app.



5. Generating and Sharing Reports — Explore Page
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DOWNLOAD

~  Past Week <= All Types

Map Filter On

All Projects -

L,
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Report in PDF format

Data in CSV format

You can generate reports that summarize
TEC waste observations that can be easily
shared to intended audiences (e.g., friends,
elected officials) as a PDF. You may also
download the data files of observations in
CSV format. These can be saved to your
location of choice.

Key Findings

* Data collection: Feb 17, 2025 to Mar 19, 2025

« Total TEC waste items observed: 21

* Total TEC waste items picked up: 7 Files
« Projects Involved: Kris' Kool Project

Area Where TEC Waste Was Recorded
74 \‘: < Legend:

Q@ Butts

2 : Q Other Tobacco Products

Q Ecg

i S ] : ! y Q Connabis

T2 A F Multipurpose
i ] (ex: lighters, rolling papers)

° Unsure

These reports provide automatically
generated summaries and tables detailing
key information, including location, dates,
waste types, and quantities for each
observation. They also indicate whether
the waste was collected, to provide a
comprehensive overview of the data.

s~ Past6Months @ Cannabis DOWNLOAD
T
o
]
& i
.
=)
=
%)
A ® 5 5
% = F MID:CITY
P (7} o G
g P
@ 9 w
®) =S
& & .@.
2 @
5
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Use the filters to customize the data
included in your downloaded reports. You
can refine your selection by date range,
waste type, project, and location. This
allows you to generate reports tailored to
your specific needs.

6O000®

MUNICIPAL RESOURCES

You can easily share reports as PDF files
with targeted audiences through email,
social media, and text messages. The
Municipal Resources feature, found in the
Forum page, provides contact details—
such as email addresses and social media
handles—of local officials in each San
Diego city. These tools help ensure that
important data reaches decision-makers,
raising awareness and driving meaningful
action on a larger scale.



6. The Forum Page
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EDUCATIONAL RESOURCES : = FREQUENTLY ASKED QUESTIONS

EDUCATIONAL RESOURCES

» —
¥ = FREQUENTLY ASKED QUESTIONS

T
:
$

Q

SUBMIT AN
) EVENT

cte |z

General App Questions

ol armosens | = peasger

TOBACCO PRODUCT WASTE How To Use The App

IDENTIFICATION GUIDE

Outdoor Environment
Resources

TEC Products And The Environment

Explore the Education
Resources section to -
access a wealth of
@ - @ information on  TEC The FAQs provides
You can access a variety waste. Users will be roquonty . oked

of educational and local redirected to the CTE frequently asked

resources, collaborative
features, and a guide for
identifying TEC waste, as
well as the app’s privacy
policy and terms of use.

website’s Environmental
Resources, where you
can find downloadable
infographics, documents,
videos, and more.

questions, to learn about
effective app usage and
impacts of TEC waste,
and to explore the app’s
functionalities.

TOBACCO WASTE IDENTIFICATION
GUIDE

<Tobacco Product Waste L\ @
Identification Guide

4. - Other Tobacco
Butts and Filters v Products

E-Cigarettesand

Cannabis Vapes

'. Multipurpose ;7

The Tobacco Product Waste Identification
Guide features clear photos and simple
descriptions to help users quickly recognize
and correctly identify the many different
types of TEC waste.

MUNICIPAL RESOURCES

& Municipal Resources [\ @

San Diego County

Cities in San Diego County

Find Your Local Elected Officials

View the Municipal Resources section for
city-specific information on environmental
and tobacco-related policies, initiatives,
and key contacts. This section helps
provide valuable insights into local efforts
to address TEC waste and offers tools to
help you engage with officials working
toward positive change in  your
community.



6.6

LOCAL
EVENTS

6.7

& Local Events

Upcoming Past

LO

Stay informed and get
involved by exploring
local events focused on

tobacco  waste and
environmental
initiatives. From

community cleanups to
educational workshops
and policy discussions,
these events  offer
opportunities to learn,
take action, and connect
with others who are
passionate about making
a difference.

E‘g PRIVACY POLICY

iKickButts

Privacy Policy

Privacy Policy
Last Modified on April 24

This privacy policy ("Pri
deser and

Your Consent

About iKickButts - App Resources v  Contact

- 3 H
1/10 + | & e i 1 Wi
a

Policy”) of the iKickButts.org website, i0S App, and Android App

& All Projects 0O
View the  Municipal
Resources section for

city-specific information
on environmental and
tobacco-related policies,
initiatives, and  key
contacts. This section
helps provide valuable
insights into local efforts
to address TEC waste
and offers tools to help
you engage with officials
working toward positive
change in your
community.

6.10

iKickButts

Terms of Use

ur Affiliat

- + |

END USER LICENSE AGREEMENT

Revised April 24, 2025

SUBMIT AN
EVENT

SDSU

E

San Diego State
University

What would you like to request?
O | want to create a new project
O I want to create a new event

O 1 want 10 promote an existing event

You can submit your own
events and projects by

tapping the relevant
buttons in the forums
section. Share cleanup
efforts, campaigns, or

community initiatives to
engage others  and
spread awareness.

About iKickButts ~ App Resources ~ Contact

[«
il

at https:/fikickbutts.org/privacy -pol

For details on how we collect, use, and
protect your personal information, please
view or download our full Privacy Policy.
https://ikickbutts.org/privacy-policy/

Visit

of Use,

to learn more.

website. Visit

By using this app, you agree to our Terms
which outline your
responsibilities, and the rules governing
the app’s features and content. Please view
or download the full Terms of Use on our

rights,

https://ikickbutts.org/terms-

of-use/ to learn more.

10
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7. Options for Single Observations — Explore Page

Observations 0©
< Past Week <5 All Types

.@.
(Omapbod

l All

My Observations

__ Mar 20, 2025 - 1:32pm

& ktran Rild
==

Mar 20, 2025 - 1:30pm
ktran

Tap the three dots next to
any observation to access
the available actions for
that observation.

Edit My Observation

Edit Observation

Edil Ihe obser valion dole Mar 20, 2025
Edlit the report ime: 1:32PM
Was tre woste picked uo? »
Project Kris' Keol Project »
Add Notes

CANCEL SAVE POST

To edit an observation,
tap the three dots next to
it and select “Edit
Observation” to update
the details of the
observation.

Edit My Observation

Add to a Project

Share Observation

Favorite Observation

If the observation is one
that you submitted, you
can edit, share, or favorite
the observation. You can
also add the observation
to a specific project.

(

None

Kris' Kool Project

SDSU Research Foundation

Observations can be added
to any projects you have

joined.

View Observation

Share Observation

Favorite Observation

If the observation was one
that another user
submitted, you can view,
share, or favorite the
observation.

</Share W Favorite

7 Feb 19. 2025 - 5210m

# Waste not picked up
o e

Grantlle

Tap “View Observation” to
view details about other
users’ observations, such
as date and time, tagged
items, and location.

11



7 7 Edit My Observation
.

Add to a Project

Share Observation

Favorite Observation

Edit My Observation

7.8

Please wait...
o

1image
Options >
AirDrop Messages Mail Snapchat

You can share individual observations via
email, text messages, or through various
social media platforms

8. Profile Page

8.1 L0

kris

ktran

B8 sbsu

® Level2

@ Observations: 152

A Edit profile
Mt

[ Logout I

4 badges left to reach Level 3

Achievements

@ (@ © ©

Level 1 Level 2 Level 3 Level 4
@) M @

Explore Forum Profile

Tapping on the “Profile” tab will allow you
to see details about your account, such as
your username, user level, observation
count, and badges.

Add to a Project

& Favorites

Dec 19, 2024 - 2:32pm
i sarchl

Jan 14, 2025 - 12:56pm

Share Observation

Favorite Observation >

KickButrs! @
Jan 15, 2025 - 1:57pm
e
(P, Feb 04,2025 - 9:43am
. i}

Feb 10, 2025 - 9:22am

Krstinotasl @

. Feb 11, 2025 - 3:41pm
; 0}

ssimich

¢ ot

Mark observations as favorites for quick and
easy viewing through your Profile tab.

8.2 a1

I

I Logout I

Achievements

Level 1

App Name version Bulld

IKickButts 0057 250319001
@ M ®
Explore Forum Profile

The bottom of the Profile tab provides
important information about the app,
including the version and build numbers.

12



8.3

8.4

4 badges left to reach Level 3

& Edit Profile 0O

Achievements

OJOX.-

Level 2

UPLOAD PHOTO

0o

Username
ktran
Level 10
Name
App Name Version Build
IKickButts 0.057 250319001 kris
@ L @
Explore Forum Profile
Email
Monitor how close you are to the next level ktran14@sdsu.edu
or badge by reviewing your progress. Each
badge represents a specific
accomplishment, such as completing When editing your profile, you can update
challenges, reaching certain milestones, or key details such as your profile picture,
engaging with the community. username, display name, and email address.
8.5 8.6
& Edit Profile 0©

Change Password

Tell us more about your position:
Confirm Password

Hide my Profile?

Are you associated with an ‘
Institution/Organization? DELETE ACCOUNT UPDATE PROFILE
Institution/Organization Name:

@ L Q@

SbsuU

Tell us more about your position:

Explore Forum Profile
Easily change your password, update your At the bottom of the page, tap “Update
adjust privacy settings to hide your profile, Profile” to save your changes. Or, tap
and list any affiliated institutions or “Delete Account” to delete your account

organizations. and all associated user data.



9. General Help and Support

|01 | prvs -

Q o General App Questions

& Notifications

How To Use The App

. Great job, a reviewer has viewed your ow B T e U UL L
=" observation and added comments.

Congratulations! You have unlocked your first 2

achievement. min Teachers and Educators

Science and Research
Other Stakeholder Organizations

Tapping on the bell icon (£) will display any Tapping the quest|or.1 mark icon (?) will take
pending notifications from the app. you to the FAQ section for helpful answers

to common questions.

iKickButts

Tobacco, E-Cigarette and Cannabis
Waste

Forgot Password X

Note : If your email address is valid, you will recelve a reset
code to reset your password

If you forget your password, tap “Forgot If you encounter any difficulties during the
Password” on the login screen. Enter your download or usage process, please contact
registered email address, and we’ll send our team at contact@ikickbutts.org, and

you a link to reset your password. they will be happy to assist you!
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